Experiment 4
Hardware Trojan Attack |

We describe an experiment on hardware Trojan attacks, in the form of
malicious modifications of electronic hardware, that pose major security
concerns in the electronics industry.

Instructor: Dr. Swarup Bhunia
Co-Instructors/TAs: Shuo Yang and Reiner Dizon-Paradis
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L Case Study

security concerns in the electronics industry.

We describe an experiment on hardware Trojan attacks, in the form of malicious modifications of electronic hardware, that pose major

In this chapter, we describe an experiment on hardware Trojan attacks and countermeasures. Emerging trend of outsourcing the design and
fabrication services to external facilities as well as increasing reliance on third-party Intellectual Property (IP) cores and electronic design

automation (EDA) tools makes integrated circuits (ICs) increasingly vulnerable to
hardware Trojan attacks at different stages of its life-cycle. The modern IC design,
fabrication, test and deployment stages highlight the level of trust at each stage. This
scenario raises a new set of challenges for trust validation against malicious design
modification at various stages of an IC life-cycle, where untrusted
components/personnel are involved. In particular, it emphasizes the requirement of
reliable detection of malicious design modification made in an untrusted fabrication
facility, during the post-manufacturing test. It also imposes a requirement for trust
validation in IP cores obtained from untrusted third-party vendors.

Figure 1 illustrates different steps of a typical IC life cycle and the possibility of Trojan
attacks in these steps. Each party associated with the design and fabrication of an IC
can be a potential adversary who can tamper it. Such tampering can be accomplished
through add/delete/alteration of circuit structure or through modification of
manufacturing process steps that cause reliability issues in ICs. From an attacker’s
perspective, the objective of such attacks can be manifold, e.g., to malign the image of
a company to gain competitive edge in the market; disrupt major national
infrastructure by causing malfunction in electronics used in mission-critical systems; or
leak secret information from inside a chip to illegally access a secure system.
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Figure 1 Hardware Trojan attacks by different parties at different
stages of IC cycle.
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SlTheory Background

Recently Intel announced a flaw in the implementation of the “TSX” instruction for its Haswell series of Central Processing Unit (CPU). This
announcement came almost a year into the product’s lifecycle and almost three years since the beginnings of Haswell’s architecture was laid
out. This is a legitimate mistake on Intel’s part — there is no foul play or trickery here.

ombinationa)

However, researchers at the University of Massachusetts were able to modify an Intel lvy Bridge 7 <
processor — the series that Haswell replaced — and significantly impair the Random Number Generator \ @ ™\
(RNG) of the processor. They did this by modifying the silicon that made up actual transistor. Their Pl é) @ PO
modification is completely undetectable without a Scanning Electron Microscope (SEM) and a known ‘ —>
good chip to authenticate against. If the security of the RNG is compromised then everything generated

Original Circuit

from it is also compromised, for example, private encryption keys.

An intelligent adversary is expected to hide such tampering with an IC’s behavior in a way that makes it~ figure 2 Combinational Trojan model
extremely difficult to detect with conventional post-manufacturing testing. Intuitively, it means that the

adversary would ensure that such tampering is manifested or triggered under very rare conditions at the internal nodes, which are unlikely to
arise during testing but can occur during long hours of field operation.

Figure 2 and Figure 3 show general models of combinational and sequential Trojans, respectively. Sequential Trojan
These abstract models of Trojans are useful for studying the space of possible Trojans, and, similar to
fault models, help in test vector generation for Trojan detection.

Figure 3 Sequential Trojan Model
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SExperiment Set-up: Configuration
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1. The instruments needed for this experiment are the HaHa Board, a USB A to B cable, a USB Blaster, and a computer.
2. The software needed is Quartus, version 15 or higher.

3. Refer to the HaHa User Manual to see the steps of configuring the Altera MAX 10 FPGA.
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FExperiment Set-up: Instructions

In this experiment, you will need to implement a DES (Data Encryption Standard) into the Altera MAX 10 FPGA, and then hack it by inserting two
kinds of hardware Trojan into it.

64-bit plaintext

| Part I: Implement a DES

Tnibi permuiation ors The DES is a symmetric-key algorithm for encrypting electronic data. Although it is now
y considered insecure, it was highly influential in the advancement of modern cryptography.
Round 1 < 4;‘m ? It uses 16 round Feistel structure. The block size is 64-bit, of which DES has an effective key
i . g length of 56 bits since 8 of the 64 bits of the key are not used by the encryption algorithm.
Round 2 T i;i se-bitcipher key  1NE €NCryption steps are illustrated in Figure 4.
K:m § Download the 12 Verilog files from Canvas related to the DES implementation on the FPGA.
Round 16 a8t If you prefer VHDL, you can use any open-source module online. Create a new Quartus

project called expt4_1 with top module called des, which is located in des . v Verilog
file. Refer to Figure 5. There are two modules inside this file: des and des_o. des_o
contains the DES implementation, and des is the wrapper top module that instantiates
des_o. Plaintext and key are given in des. There is a RAM module called ram1 instantiated,
Figure 4 DES encryption illustration. which is a 64-bit wide, 32-word deep RAM. It will store all the encryption results of the 16
rounds. All the submodules are given except the raml module.

Final permutation

64-bit ciphertext

Import these Verilog files by going to Project > Add/Remove Files in Project... window. Click on ... next to File name text box. Locate the
downloaded files, select them all, and click Open. Then, click OK. You should create the raml module from ‘RAM: 1-PORT’ of the installed IP
with exactly the same name ‘ram1’ with exactly the same size. Make sure it can be captured by the In-System Memory Content Editor in the last
step of Parameter Settings. Refer to the Appendix: RAM Instantiation on Quartus software for visual instructions of instantiating this module.
Module div1i is added to slow down the clock so that an error will not be caused due to a fast clock. You can even make it slower.

Inside your Quartus project directory, locate and open expt4_1.qsf file. Add the following lines to the end of that file:
set_location_assignment PIN_88 -to clk_in
set_location_assignment PIN_30 -to rst

These lines maps c1k_in and rst ports from the des top module to pins 88 and 30 on the FPGA. Alternatively, you can do this mapping using
the ‘Pin Assignment’ tool in Quartus.
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Figure 5 New Project Wizard

Part Il: Insert a combinational Trojan

Insert a combinational Trojan into the DES circuit you implemented in Part |. The trigger
condition of the Trojan is when the output of the F function (Figure 6) satisfies for some
value of the least significant 4 bits (see next section). When the Trojan is triggered, the LSB of
the input key (NOT round keys) for the DES is inverted. When the trigger condition is not
true, the key becomes the original input key.

Part Ill Insert a sequential Trojan

Insert a sequential Trojan into the DES circuit you implemented in Part |. Use the same clock
as the DES circuit. The trigger condition of the Trojan is when the least significant 2 bits of
the F function output in order go through some order of three values at the negative edge of
the clock (see next section). After the Trojan is triggered, the LSB of the input key (NOT
round keys) for the DES will always be inverted.
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# Measurement, Calculation, and Question
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Answer the following questions.

Part I: Implement a DES
1) Use the plaintext and key provided and add them in the des.v Verilog file:
desIn=64'hA42F891BD376CEQ5
key64 = 64'h0123456789ABCDEF

If you choose to use other open source VHDL code, also use the same plaintext and key. Store all the encryption results for the 16
rounds in an implemented RAM and show them in In-System Memory Content Editor (‘Editor window’ below). Turn in a screenshot.
2) Which module is creating the key for each round? By how?
3) Which module is doing Feistel function?
4) How many Logic Elements are used?

Part II: Insert a combinational Trojan

1) Turn in your code when the trigger condition is 4’b0110. Only turn in the Verilog files that have been changed and Verilog files (if there
are) that are created by you.

a. When the trigger condition is 4’b0110, will the Trojan be triggered? How many times is it triggered in the 16 rounds? Turnin a
screenshot of the Editor window.
2) When the condition is 4’'b1001, repeat answering question 1) again.
3) When the condition is 4’b1010, repeat answering question 1) again.

Part Ill: Insert a sequential Trojan
1) Turnin your code when the trigger condition is 2’b01->2’b10>2’b11. Only turn in the Verilog files that have been changed and Verilog
files (if there are) that are created by you.
a. How many states are needed in total? How many additional registers have you implemented?
b. When the trigger condition is 2’b012>2’b10>2’b11, will the Trojan be triggered? How many times is it triggered in the 16
rounds? Turn in a screenshot of the Editor window.
2) When the condition is 2’b01->2’b10>2’b11, repeat answering question 1) again.
3) When the condition is 2’b11->2’b01->2’b00, repeat answering question 1) again.
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# Optional Follow-up
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Part IV: Change the trigger condition
Change the trigger condition of the Trojan you inserted in Part Il to be acceleration value from the accelerometer.

Use the hex file you downloaded for Experiment 3 (Bus Snooping Attack), make the Atmel AVR microcontroller to run the code when the FPGA is
running DES. The microcontroller will keep sending acceleration data to the FPGA through the 8 interconnections.

1) If the longitudinal direction of header P3 is x and the longitudinal direction of header P4 is y, on which direction is the sensor sensing the
acceleration?
2) Add an 8-bit input for the DES to accept the acceleration data. When the board is more than 45-degree up tilted (in the right direction),

the Trojan will be triggered, and the payload is the same with the Trojan in Part Il. Turn in your Verilog description (or VHDL code). No
screenshot is needed.
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® Lab Report Guidelines and Demonstration

Deliverables:

1. Inyourreport, give answers to ALL the questions.
In part |, give a screenshot after compiling the DES code.
Give a photo, or a screenshot to prove your DES works well.
Give all the code that is required.
Attach screenshots as required.
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Demonstration:
Please take videos of the demonstration and include them to your submission.

1. For part |, show your encryption result.
2. For part Il, show the result when the combinational Trojan is triggered.
3. For part lll, show the result when the sequential Trojan is triggered.
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Appendix: RAM Instantiation on Quartus software

The following are the steps to instantiate the RAM module on the Quartus software:
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1. Goto Tools > IP Catalog

File Edit View Project Assignments Processing Tools Window Help

O r Run Simulation Tool s LR 9

Launch Simulation Library Compiler

2

- Home [x]
LS

(]

Project Navigator % Hierarchy valpe x| #

Launch Design Space Explorer ||

#% Compilation Hierarchy

Timing Analyzer

E New Project Wizard ﬂ Open Project
Advisors

Chip Planner

Desgn Partition Flanner Q S (3} ) -
Netlist Viewers Compare Editions Buy Software Documentation Training Support What's New Notifications

signal Tap Logic Analyzer

In-System Memary Content Editar
Logic Analyzer Interface Editor
In-System Sources and Probes Editor
Signal Probe Pins...

Programmer

JTAG Chain Debugger

Fault Injection Debugger

System Debugging Tools

IPcatalog [
Tasks Compilation v Nios Il Software Build Tools for Eclipse
Task Platform Designer
v Comipile Design A TclScripts
> Analysis & Synthesis
L - Customize...
> Fitter (Place & Route) Options
> Assembler (Generate programmin| License Setup.

Install Devices..

® Program Device (Open Programmer]

lose page aftel

B pon't show this screen again

< >

x

a|la B & A A [FFie 8 rind. | |88 Find Next
i}

= ||Type  ID  Message

-

2

E System  Processing

Opens the IP Catalog Tool 0%  00:00:00
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2. The IP Catalog sidebar will show up on the right side of the window. Search for ‘ram: 1’ and click on ‘RAM: 1-PORT’.

File Edit View Project Assignments Processing Tools Window Help

Ot r -

Project Navigator 4 Hierarchy ~aae x| #

% DaV@ 9
Home [}

*ﬁ New Project Wizard
Q @ il

Compare Editions Buy Software

#% Compilation Hierarchy

ﬁ‘. Open Project

Tasks Compilation MELE -
Task
v

>

> Fitter (Place & Route)

> Assembler (Generate programmin|
> P> Timing Analy

> EDA Netlis
B Edit settings

W Program Device (Open Programmer)

Close page after project load

B pon't show this screen again

88 Find.. | |8 Find Next

<
gllar @ & A (A [T ccriterss
P

Type ID  Message

Documentation Support ‘What's New Notifications

|IP Catalog 8 x |

Device Family | MAX 10 (DA/DF/DC/SA/SC) ¥

[ & ram: x| =
~ Gl installed IP

¥ Library

V¥ Basic Functions
~ On Chip Memory
# RAM: 1-PORT
@ search for Partner IP

+ Add

System  Processing
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The MegaWizard Plug-In Manager window will open. Set the following then click Next:
How wide should the ‘q’ output bus be? 64 bits
How many 64-bit words of memory? 32 words

M- LY DA @

Project Navigator, &% Hierarchy -alga x

i Compilation Hierarchy

[ oo

Compare Editions

yte Enable/Acks Read During Mem Init

Currently selected device famiy: [jax 10 =

Match project/default

address[4.0]

How wide should the ' output bus be? | bits

How many 64-bit words of memory? 37 ~ | words

Note: You could enter arbitrary values for width and depth
Elock type: AUTO What should the memary block type be?

@ Auto MLAB ) MK
M144K O Les
Set the maximum block depth to words

What clocking method wouid you like to use?
@ Single dock

Tasks Compilation =

Task

Compile Design

- O Dual dock: use separate input’ and ‘output’ docks
& Synthesis
Fitter (Place & Route)

Assembler (Generate programmin

Timing

EDA Netlist w
B Edit settings

O Program Device (Open Programmen

Close page after project load

‘\Pca!atog o x ‘

Device Family | MAX 10 {DA/DF/DC/SA/SC) ¥

& am1 x| =

~ 2k installed 1P
~ Library
V¥ Basic Functions
¥ On Chip Memaory
# RAM: 1-PORT
@ search forPartner P

| Cancel H <Back H Next > H Finish ‘

< N B pon't show this screen again + add
x|

alal Q& A A S rind.. | |88 Find Next

a

= | Type ID Message

8

1l

| system  Processing
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4. Check the box for ‘q’ output port and click Next.
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Project Navigator ¢ Hierarchy ralge x| # Home [x]

‘\Piahlog RE x ‘

i Compilation Hierarchy
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Device Family |MAX 10 (DA/DF/DC/SA/SC) T
[® ram: 1 x| =

v 4k Installed IP
¥ Library

| -

~ On Chip Memor
Compare Editions a " &

™ Basic Functions

# RAM: 1-PORT
MemInt @ search for Partner P

Which parts should be registered?

data[63.0) 'data’ and ‘wren' input ports

wren

Address4 0] ‘address' input port

'q output port

Create ane clock enable signal for each dock signal.
[ note: All registered ports are contralied by the More Options...
enable signal(s)

[] Create byte enable for port &

Block type: AUTO

What s the width of a byte for byte enables? | 3

Tasks Compilation MEILLE O Cﬂ’fr‘:;s"hggg S:xs‘d"“"“s =i More Options...
Task [ Create a ‘rden read enable signal
~ P Compile Design
> Analysis & Synthesis

> Fitter (Place & Route)

Assembler (Generate programmin

> P Timing Analysis
> EDA Netlist Writer
W cdit Settings

™

Program Device (Open Programmer)

2 MK

Close page after project load

[[cancel ][ <Back |[Timt> |[ Fnisn |

B pon't show this screen again

> + Add..
[x | _
ala @ A& A A |V > B8 Find... |88 Find Next
a
= || Type i Message
8
i
8| system  Processing
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5. Leave the settings as is and click Next.

[ p
0O r= r
Project Navigator 4% Hierarchy Qe x

i Compilation Hierarchy

Tasks Compilation vi=lga =

Task

Compile Design

Analysis & Synthesis
Fitter (Place & Route)
Assembler (Generate programmin
Timing Analysis
EDA Netlist Writer

W cdit Settings

D Program Device (Open Programmer)

(O OAVE @

Home

Compare Editions

data[63 0

wren

Address( 0

Block type: AUTO

2 MK

Close page after project load

B pon't show this screen again

anl D A A A

88 Find.. | |8 Find Next

IIIhmx‘

Type ID Message

‘\Piahlog RE x ‘

Device Family | MAX 10 (DA/DF/DC/SA/SC) ¥

® am 1 X =
| \

v 3 Installed IP
¥ Library
~ On Chip Memory
# RAM: 1-PORT

Mem Tnit @ search for Partner P

Single Port Read-During-\rit= Option

What should the q autput be when reading from a

Gat ¥'s for write masked bytes instead of old data when
byte enable is used

| Cancel H <Back H= Next > \| Finish \

+ Add..

e

System  Processing
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6. Check the box for Allow In-System Memory Content Editor to capture and update content independently of the system clock.

The ‘Instance ID’ of this RAM is: ram1

Ors r -
valps x| #

LY DAED 9

Home

Project Navigator & Hierarchy

4% Compilation Hierarchy

oy by

d Plug-In Manager [page 4 of ]

Q £} RAM: 1-PORT

Compare Editions

Enal

data[63 0

Wwren
|address[4 0]

dock.

Block typs: AUTG

[Tasks Compilation

Task

Compile Design

is & Synthesis

er [Place & Route)
Assembler (Generate programmin,

Timing An:

EDA Netlist
B Edit Settings

Resource Usage

¥ Program Device (Open Programmer)

‘\Pcahmg ne = ‘

Device Family | MAX 10 (DA/DF/DC/SA/SC) ~

[ ram x| =
v installed 1P
~ Library

[ | femern W

¥ Basic Functions
¥ On Chip Memory

# RAM: 1-PORT
blejadcs > Read During Writ @ search for Partner IP

Do you want to specify the initial content of the memory?
(® No, leave it blank

D Initislize memory content data to XX..X on
power-up in simulation

(D Yes, use this file for the memory content data

(You can use & Hexadecimal (Intel-format) i [.hex] or a Memory
Tnitialization File [.mif])

Note: The configuration scheme of your device is Internal Configuration. In
order to use memory initislization, you must select a single image

mode with memary r example the Single
Compressed Image with Memory Initialization option. You can set the
configuration mode on the Configuration page of the Device and Pin Options
dialog box.

Browse...

File name:

The inifial content file should conform to which ports
dimensions?
Allow In-System Memory Content Editor to capture and

update content independently of the system dock

The 'Instance ID' of this RAM is:

2M9K

Close page after project load

B pon't show this screen again

[[cancel ][ <Back |[ mext> |[ Frisn |

> + Add..
x|

a|al @& A A [Fcritess BBrind . |8 Find Next

a

= || Type ID Message

3

d

8| system  Processing

Then, click Next.
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7. Leave the settings as is and click Next.

D r (O OAVE @

Project Navigator, &% Hierarchy algs x

i Compilation Hierarchy

Compare Editions

Tasks Compilation vi=lga =

Task

Compile Design
Analysis & Synthesis
Fitter [Place & Route)
Assembler (Generate programmin
Timing Analysis

EDA Metlis

W cdit Settings

D Program Device (Open Programmer)

Close page after project load

B pon't show this screen again

Block type: AUTO

2 MK

[ |psmmeraer

Simulation Libraries

To properly simuiate the generated design files, the following smulstion modsl
fie(s) are neede

File Description

altera_mf  Altera megafunction simulation library

Timing and resource estimation

Generates 2 netiist for timing and resource estimation for this megafunction. If you
are synthesizing your design with a third-party EDA synthesis tool, using a timing
and resource estimation netlist can allow for better design optimization.

Not all third-party synthesis taols support this feature - check with the tool vendor
for complete support information,

Note: Netlist generation can be @ time-intensive process. The size of the design
and the speed of your system affect the tme it takes for nefist generatian to
complete.

[ Generate netist

(e | [2m | (30> | [ |

‘\Piahlog RE x ‘

Device Family |MAX 10 (DA/DF/DC/SA/SC) T
[® ram: 1 x| =

v 4k Installed IP
¥ Library

~ Basic Functions
~ On Chip Memory
# RAM: 1-PORT
@ search forPartner IP

< > + Add..
[x |

Al B & A A <<Filters> B8 Find... |88 Find Next

a

= | Type ID  Message

il

i

8| system  Processing
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8. Check the boxes for raml_inst.v and raml_bb.v. Then, click Finish.

co 0abE @

Home

Project Navigator 4\ Hierarchy ~alga x| @&

i Compilation Hierarchy

Q

Compare Editions

[ |psmmeraer

Turn on the files you wish to generate. A gray checkmark indicates a file that is
automatically generated, and a green checkmark indicates an optional file. Click Finish

7

‘\Piahlog RE x ‘

Device Family | MAX 10 (DA/DF/DC/SASC) ¥
[® ram: 1 x| =
v 4k Installed IP

¥ Library

~ Basic Functions
~ On Chip Memory
# RAM: 1-PORT
@ search forPartner IP

data[63..0] to generate the selected files. The state of each checkbox is maintained in subsequent
ren MegaWizard Plug-In Manager sessions.
Address[4. 0] The MegaWizard Plug-In Manager creates the selected files in the following directory:
D:\Exptay
File Desaription
Block type: AUTC ramiv Variation file
[ramvinc AHDL Include file
[Jram1.cmp VHDL component dedaration file
[ram1.bsf Quartus Prime symbol file
Instantiation template file
— Verilog HDL black-box file
Tasks Compilation ML
Task
~ P Compile Design
> Analysis & Synthesis
> Fitter (Place & Routs)
> Assembler (Generate programmin
> Timing Analysis
> EDA Netlist Writer
it Settings
D
Program Device (Open Programmer) 219K [Conca | [<ea || o> | [ ]
Close page after project load
, B Don't show this screen again + Add..
x
ala @ A& A A |V 8 Find.. | |88 Find Next
i
= || Type i Message
8
o
8| system  Processing
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